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Introduction

Continuous mixing is used in process equipment to mix chemical species in a single pass.
Compared to batch mixing, this operation has the advantage that the tank filling and
emptying steps are eliminated, meaning that the process can be run without interruptions.
On the other hand, the disadvantage of continuous mixing is that time the material spends
in the mixer, the residence time, is not uniform. The residence time is to a large extent
dependent on the details of the mixer construction and the operation. Parameters that
affect the residence time are, for example, the position and speed of the impeller and the

feed rate.

Model Definition

In this model a tank with an asymmetrically positioned impeller is studied. The impeller is
attached to a shaft protruding from the wall as seen in Figure 1. The tank is also fitted with
a tubular inlet and outlet, positioned at the top and bottom of the tank. The tank and
impeller geometry are defined using parts from the Mixer Module Parts Library. A liquid
is continuously fed into the tank near the top. At the same time liquid exits through an
outlet at the bottom of the tank. The impeller rotates at 15 rpm resulting in a turbulent
flow of the liquid. The flow field resulting from the impeller agitation is solved for using a

frozen rotor analysis.

The mixing process and the residence time distribution are evaluated using particle tracing
of massless particles. A benefit of using particles is that a distinct pulse to be injected is
casily modeled, for example by distributing all particles on the inlet boundary at the initial
time step. In addition, the number of particles to track, and thus the computational
requirements, can be controlled. This in contrast to solving for a continuous concentration
field, in which case the concentration in all points of the mesh need to be solved for in each
time step. This could be a substantial effort since a long simulation time is typically needed

when evaluating the mixing in a stirred tank.

In the present model, a pulse containing 50,000 massless particles are injected at the feed
inlet and subjected to the flow field from the frozen rotor simulation. The particles are
tracked as they flow through the mixer until they exit at the outlet. A particle counter
feature is used at the outlet to track the number of particles that exit the tank.
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Inlet

Figure 1: The continuous mixer geometry including a tank fitted with a tubular inlet and
outlet. The tank is agitated by an impeller attached to a shaft protruding from the tank wall.

Results and Discussion

Figure 2 shows the computed velocity field. The inlet stream is seen to propagate through
the tank and turn at the opposite wall. Fluid is drawn downward in the vicinity of the
impeller. Along the outer walls the fluid in general flows upwards. This implies that a fluid
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parcel that does not pass close to the outlet when arriving at the bottom will be transported

up again along the tank walls.
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Figure 2: The frozen rotor flow field in the mixer visualized at five positions.

The trajectories of the injected particles after 100 s of simulation time are plotted in
Figure 3. Each particle is represented by a cone pointing in direction of the particle
velocity. At this time, the particles are distributed throughout the whole vessel, but still
mostly in certain bands. Some of the particles are seen to have passed the outlet. These
particles are still at the outlet since a freeze condition is applied. The particles are colored
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by the velocity magnitude. As expected, particles close to the impeller are subjected to
higher velocities. However, the highest velocities occur inside the tubular outlet channel.

Time=100s Particle trajectories Surface: 1 (1)

Figure 3: Flow patterns inside the test apparatus with water at 1 m/s.

By injecting a pulse input of a tracer species into a reactor or mixing vessel, and
subsequently measuring the concentration C(t) at the outlet, the residence time
distribution function E(#) can be defined as (Ref. 1)

E@t) = S0 1)

00

j C(t)dt
0
The residence time distribution function can be said to quantify how much time different
fractions of the total amount of species being mixed have spent in the vessel. Using an

integral form, the fraction of the tracer species leaving the vessel that have spent between
times ¢ and £y inside the vessel can be defined as

2
8 ¢, = | Bt @)

In the present model, the tracer species are as discrete particles, meaning that the

concentration at the outlet is not known in each time step. To estimate the concentration,

5| CONTINUOUS MIXER



the number of particles that exit the tank over a short time is computed. In Figure 4, the
residence time distribution, using a sampling time of 10 s, is plotted. No particles exit
before 80 s. There are two notable peaks, at 150 s and 300 s, with significant ejection of
particles, before the distribution levels out. The fraction remaining in the tank is also
plotted. More than 60% of the particles remain in the tank after 500 s, corresponding to
125 rotations of the impeller.
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Figure 4: Residence time distvibution for the pavticles injected into the mixer.
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Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click [l 3D.

2 In the Select Physics tree, select Fluid Flow>Single-Phase Flow>Rotating Machinery,
Fluid Flow>Turbulent Flow>Turbulent Flow, k-c.

Click Add.

Click e Study.

In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Frozen Rotor.
Click E,/ Done.

Load the model geometry from a geometry sequence.

o U1 A W

GEOMETRY |

I In the Geometry toolbar, click Insert Sequence and choosc Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file
continuous_mixer_geom_sequence.mph.

3 In the Geometry toolbar, click [E2 Build All.

GLOBAL DEFINITIONS

Parameters |

I In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
continuous_mixer_parameters.txt.

Parameters 2

I In the Home toolbar, click Pi Parameters and choosec Add>Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file
continuous_mixer_mesh_parameters.txt.

DEFINITIONS

Impeller Blades
I In the Model Builder window, expand the Component | (comp1)>Definitions node.

2 Right-click Definitions and choose Selections>Explicit.

3 In the Settings window for Explicit, type Impeller Blades in the Label text field.

4 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
5 Select Boundaries 22, 23, 25, 26, 35, and 4448 only.

Blade edges

I In the Definitions toolbar, click " Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 From the Geometric entity level list, choose Edge.

4 Seclect Edges 31-42,47-52, 54, 60-64, 75, 76, 101-104, 106, 108, 109, 112-122,
and 124-139 only.

5 In the Label text field, type Blade edges.

ADD MATERIAL

I In the Home toolbar, click =57 Add Material to open the Add Material window.
2 Go to the Add Material window.

3 In the tree, sclect Built-in>Water, liquid.

4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click 37 Add Material to close the Add Material window.

TURBULENT FLOW, K-c(SPF)

I In the Model Builder window, under Component | (compl) click Turbulent Flow, k- (spf).
2 In the Settings window for Turbulent Flow, k-¢, locate the Physical Model section.

3 Select the Include gravity check box.

4 Select the Use reduced pressure check box.

Interior Wall |

I In the Model Builder window, expand the Turbulent Flow, k- (spf) node.

2 Right-click Component | (compl)>Turbulent Flow, k-¢ (spf) and choose Interior Wall.
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3 In the Settings window for Interior Wall, locate the Boundary Selection section.
4 From the Selection list, choose Impeller Blades.
Inlet |
I In the Physics toolbar, click mw Boundaries and choose Inlet.
Select Boundary 1 only.
In the Settings window for Inlet, locate the Boundary Condition section.

2

3

4 From the list, choose Fully developed flow.

5 Clear the Apply condition on each disjoint selection separately check box.
6

Locate the Fully Developed Flow section. In the Uy, text field, type v_in.
Outlet |
I In the Physics toolbar, click mw Boundaries and choose Outlet.
2 Select Boundaries 51, 52, 54, and 55 only.
Wall 2
I In the Physics toolbar, click mw Boundaries and choose Wall.
2 Select Boundary 10 only.
3 In the Settings window for Wall, locate the Boundary Condition scction.

4 From the Wall condition list, choose Slip.

MOVING MESH

In the Model Builder window, expand the Moving Mesh node.

Rotating Domain |
I In the Model Builder window, expand the Component | (comp1)>Moving Mesh>
Rotating Domain | node, then click Rotating Domain 1.

In the Settings window for Retating Domain, locate the Domain Selection section.
From the Selection list, choose Manual.

=
Click [T} Clear Selection.

Select Domain 4 only.

o U1 A W N

Locate the Rotation section. From the Rotational velocity expression list, choose

Constant angular velocity.

7 In the o text field, type Omega.
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8 Locate the Axis section. Specify the ryy vector as

0 X

-0.175 Y
0.5 z

9 Specify the u, vector as

0 X
-sin(impellerTilt[deg]) Y
cos(impellerTilt[deg]) z

ADD PHYSICS
I In the Physics toolbar, click i Add Physics to open the Add Physics window.

Go to the Add Physics window.
In the tree, select Fluid Flow>Particle Tracing>Particle Tracing for Fluid Flow (fpt).

2

3

4 Click Add to Component | in the window toolbar.

5 In the tree, select Fluid Flow>Particle Tracing>Particle Tracing for Fluid Flow (fpt).
6

In the Physics toolbar, click i Add Physics to close the Add Physics window.

PARTICLE TRACING FOR FLUID FLOW (FPT)
I In the Settings window for Particle Tracing for Fluid Flow, locate the

Particle Release and Propagation scction.
2 From the Formulation list, choose Massless.
3 Locate the Additional Variables section. Select the Store particle release statistics check

box.

Wall |
I In the Model Builder window, under Component | (compl)>
Particle Tracing for Fluid Flow (fpt) click Wall I.

2 In the Settings window for Wall, locate the Wall Condition section.
3 From the Wall condition list, choose Disappear.

Particle Properties |

I In the Model Builder window, click Particle Properties 1.

2 In the Settings window for Particle Properties, locate the Particle Properties section.
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3 Specify the v vector as

u X
vy
w  z
Inlet |

I In the Physics toolbar, click mw Boundaries and choose Inlet.

2 Select Boundary 1 only.

3 In the Settings window for Inlet, locate the Initial Position section.

4 From the Initial position list, choose Random.

5 In the N text field, type nPart.

Outlet |

I In the Physics toolbar, click mw Boundaries and choose Outlet.

2 Select Boundaries 51, 52, 54, and 55 only.

Particle Counter |

I In the Physics toolbar, click mw Boundaries and choose Particle Counter.

2 Select Boundaries 51, 52, 54, and 55 only.

MESH 1

Size |

In the Model Builder window, under Component | (compl) right-click Mesh I and choose
Size.

Size

I In the Settings window for Size, locate the Element Size section.

2 From the Predefined list, choosc Coarse.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type

h_dom_max.
In the Minimum element size text field, type h_dom_min.
In the Maximum element growth rate text field, type h_dom_growth.

In the Curvature factor text field, type h_dom_curvef.

0 N o wn

In the Resolution of narrow regions text field, type h_dom_narrowres.
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Size |
I In the Model Builder window, click Size 1.

In the Settings window for Size, locate the Geometric Entity Selection section.
From the Geometric entity level list, choose Boundary.

Click to select the Activate Selection toggle button.

Select Boundaries 2-9, 14, 15, 22, 23, 25-38, 40, 42-50, 53, and 56 only.

2
3
4
5
6 Locate the Element Size section. From the Predefined list, choose Fine.
7 From the Calibrate for list, choose Fluid dynamics.

8 Click the Custom button.

9 Locate the Element Size Parameters section.

10 Select the Maximum element size check box. In the associated text field, type
h_bnd_max.

Il Select the Minimum element size check box. In the associated text field, type h_bnd_min.
12 Select the Curvature factor check box. In the associated text field, type h_bnd_curvef.
Size 2
I In the Model Builder window, right-click Mesh | and choose Size.

In the Settings window for Size, locate the Geometric Entity Selection section.

From the Geometric entity level list, choose Boundary.

From the Selection list, choose Impeller Blades.

2
3
4
5 Locate the Element Size section. From the Predefined list, choose Extra fine.
6 Click the Custom button.

7 Locate the Element Size Parameters section.

8

Select the Maximum element size check box. In the associated text field, type
h_bnd_max/2.5.

Free Triangular |

I In the Mesh toolbar, click ;i\ Boundary and choose Free Triangular.
2 Select Boundaries 1, 51, 52, 54, and 55 only.

Size |

I Right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section.
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5 Select the Maximum element growth rate check box. In the associated text field, type
h_inout_growth.

Free Triangular |
Right-click Free Triangular 1 and choose Size.

Size 2
I In the Settings window for Size, locate the Geometric Entity Selection section.
2 From the Geometric entity level list, choose Edge.
3 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.
4 From the Predefined list, choosc Extra fine.
5 Select Edges 1, 2, 4, 6, 142, 144, 150, and 155 only.
6 Click the Custom button.
7 Locate the Element Size Parameters scction.
8 Sclect the Maximum element size check box. In the associated text field, type
h_bnd_max*0.45.
Swept |
I In the Mesh toolbar, click 47, Swept.
2 In the Settings window for Swept, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.
4 Seclect Domain 1 only.
Distribution |
I Right-click Swept | and choose Distribution.
In the Settings window for Distribution, locate the Distribution section.
From the Distribution type list, choose Predefined.

2

3

4 In the Number of elements text field, type n_inlet.

5 In the Element ratio text ficld, type n_inlet_hratio.
6

Select the Reverse direction check box.

Swept 2
I In the Mesh toolbar, click 42

Swept.
2 In the Settings window for Swept, locate the Domain Selection scction.
3 From the Geometric entity level list, choose Domain.

4 Select Domain 3 only.
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Distribution |
I Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.
3 From the Distribution type list, choose Predefined.
4 In the Number of elements text field, type n_inlet*2.
5 In the Element ratio text field, type n_inlet_hratio.
Free Triangular 2
I In the Mesh toolbar, click ;i\ Boundary and choose Free Triangular.
2 In the Settings window for Free Triangular, locate the Boundary Selection section.
3 From the Selection list, choose Impeller Blades.
Size |
I Right-click Free Triangular 2 and choose Size.
In the Settings window for Size, locate the Geometric Entity Selection section.

From the Geometric entity level list, choose Edge.

2

3

4 From the Selection list, choose Blade edges.

5 Locate the Element Size section. Click the Custom button.
6 Locate the Element Size Parameters section.

7

Select the Maximum element size check box. In the associated text field, type
h_blade_max.
8 Sclect the Minimum element size check box. In the associated text field, type

h_blade_min.

Corner Refinement |
I In the Mesh toolbar, click £}

. More Attributes and choose Corner Refinement.

In the Settings window for Corner Refinement, locate the Domain Selection scection.

2

3 From the Geometric entity level list, choose Domain.

4 Click in the Graphics window and then press Ctrl+A to select all domains.
5

Locate the Boundary Selection section. Click to select the @] Activate Selection toggle
button.

6 Sclect Boundaries 2-10, 14, 15, 22, 23, 25-38, 40, 42-50, 53, and 56 only.

Free Tetrahedral |
In the Mesh toolbar, click 45}, Free Tetrahedral.
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Size |
I Right-click Free Tetrahedral | and choose Size.

In the Settings window for Size, locate the Geometric Entity Selection section.

From the Geometric entity level list, choose Domain.

Locate the Element Size section. Click the Custom button.

2
3
4 Seclect Domain 4 only.
5
6 Locate the Element Size Parameters section.
7

Select the Maximum element growth rate check box. In the associated text field, type
h_blade_growth.

Boundary Layers |

I In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click in the Graphics window and then press Ctrl+A to select all domains.

5 Click to expand the Corner Settings section. From the Handling of sharp edges list, choose
Trimming.

Boundary Layer Properties

I In the Model Builder window, click Boundary Layer Properties.
In the Settings window for Boundary Layer Properties, locate the Layers section.

In the Number of layers text field, type 5.

Select Boundaries 2-9, 14, 15, 22, 23, 25-38, 40, 42-50, 53, and 56 only.

2
3
4 In the Thickness adjustment factor text field, type bl_thicknessf.
5
6 Click [E§ Build All

STUDY |

I In the Model Builder window, click Study I.

2 In the Settings window for Study, locate the Study Settings section.
3 Clear the Generate default plots check box.

4 In the Home toolbar, click = Compute.

ADD STUDY
I In the Home toolbar, click \Ui Add Study to open the Add Study window.

2 Go to the Add Study window.
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3 Find the Studies subsection. In the Select Study tree, sclect General Studies>

Time Dependent.
4 Click Add Study in the window toolbar.
5 In the Home toolbar, click :\‘53 Add Study to close the Add Study window.

STUDY 2

Step I: Time Dependent
I In the Settings window for Time Dependent, locate the Study Settings section.

2 In the Output times text field, type range(0,1,100) range(100+deltaT,deltaT,
tEnd).

3 Locate the Physics and Variables Selection section. Select the

Modify model configuration for study step check box.
4 In the tree, select Component | (compl)>Turbulent Flow, k- (spf).
5 Click Disable in Solvers.

6 In the tree, select Component | (compl)>Moving Mesh, Controls spatial frame>

Rotating Domain 1.
7 Click @ Disable.
8 Click @ Disable.

9 Click to expand the Values of Dependent Variables scction. Find the
Values of variables not solved for subsection. From the Settings list, choose

User controlled.
10 From the Method list, choose Solution.
Il From the Study list, choose Study |, Frozen Rotor.

12 In the Home toolbar, click = Compute.

DEFINITIONS

Hide for Geometry |
I In the Model Builder window, expand the Definitions node.

Right-click View I and choose Hide for Geometry.

2
3 In the Settings window for Hide for Geometry, locate the Selection section.
4 From the Geometric entity level list, choose Boundary.

5

On the object igfl, select Boundaries 2, 3,6, 10,12, 13, 16-21, 24, 36, 39,41,49, and
53 only.
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RESULTS

In the Model Builder window, expand the Results node.

Cut Plane |

I In the Model Builder window, expand the Results>Datasets node.
Right-click Results>Datasets and choose Cut Plane.
In the Settings window for Cut Plane, locate the Plane Data section.

2
3
4 Sclect the Additional parallel planes check box.
5 From the Plane list, choose xy-planes.

6

In the Distances text field, type 0.5 1.0 1.5 1.95.

All Walls
I In the Results toolbar, click i More Datasets and choose Surface.

2 In the Settings window for Surface, type A11 Walls in the Label text ficld.

3 Select Boundaries 2-10, 14, 15, 22, 23, 25-30-32-38, 40, 42-50, 53, and 56 only.
Exterior Walls )

I In the Results toolbar, click i More Datasets and choose Surface.

2 In the Settings window for Surface, type Exterior Walls in the Label text field.

3 Select Boundaries 2-10, 14, 15, 27-34, 36-38, 40, 42, 43, 49, 50, 53, and 56 only.
Interior Walls )

I In the Results toolbar, click =i More Datasets and choose Surface.

2 In the Settings window for Surface, type Interior Walls in the Label text field.

3 Select Boundaries 22, 23, 25, 26, 35, and 4448 only.

Velocity (spf)

I In the Results toolbar, click .‘i 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Velocity (spf) in the Label text field.
3 Locate the Plot Settings scction. Clear the Plot dataset edges check box.

Surface |

I Right-click Velocity (spf) and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type 1.

4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Gray.
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Surface 2
I In the Model Builder window, right-click Velocity (spf) and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Cut Plane 1.

Transparency |

I In the Model Builder window, right-click Surface 2 and choose Transparency.

2 In the Settings window for Transparency, locate the Transparency section.

3 Set the Transparency value to 0.4.

4 In the Velocity (spf) toolbar, click Plot.

5 In the Graphics window toolbar, click ¥ next to ™ Scene Light, then choose
Ambient Occlusion.

Arrow Surface |

I In the Model Builder window, right-click Velocity (spf) and choose Arrow Surface.
In the Settings window for Arrow Surface, locate the Data section.
From the Dataset list, choose Cut Plane 1.

2
3
4 Locate the Arrow Positioning section. In the Number of arrows text field, type 900.
5 Locate the Coloring and Style section. From the Arrow type list, choose Cone.

6

From the Color list, choose Gray.
Pressure (spf)
I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.
2 In the Settings window for 3D Plot Group, type Pressure (spf) in the Label text field.
3 Locate the Plot Settings scction. Clear the Plot dataset edges check box.
Surface |
I Right-click Pressure (spf) and choose Surface.
In the Settings window for Surface, locate the Data section.
From the Dataset list, choose All Walls.

2

3

4 Locate the Expression section. In the Expression text field, type 1.

5 Locate the Coloring and Style section. From the Coloring list, choose Uniform.
6

From the Color list, choose Gray.

Pressure

I In the Model Builder window, right-click Pressure (spf) and choose Contour.
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In the Settings window for Contour, locate the Data section.
From the Dataset list, choose Exterior Walls.

Locate the Expression section. In the Expression text field, type p.
Locate the Levels section. Clear the Round the levels check box.

In the Label text field, type Pressure.

N o0 it AW N

Locate the Levels section. In the Total levels text field, type 40.

Upside Pressure

I Right-click Pressure (spf) and choose Contour.

In the Settings window for Contour, type Upside Pressure in the Label text field.
Locate the Data section. From the Dataset list, choose Interior Walls.

2

3

4 Locate the Levels section. Clear the Round the levels check box.

5 Locate the Expression section. In the Expression text field, type up (p).
6

Locate the Levels section. In the Total levels text field, type 40.
Deformation |
I Right-click Upside Pressure and choose Deformation.
In the Settings window for Deformation, locate the Expression section.
In the x-component text field, type nx/sqrt(up(tremetric)).
In the y-component text field, type ny/sqrt(up(tremetric)).

2
3
4
5 In the z-component text field, type nz/sqrt(up(tremetric)).
6 Locate the Scale section.

7

Select the Scale factor check box. In the associated text field, type 0.1.

Downside Pressure

I In the Model Builder window, right-click Pressure (spf) and choose Contour.
In the Settings window for Contour, type Downside Pressure in the Label text field.
Locate the Data section. From the Dataset list, choose Interior Walls.

2
3
4 Locate the Expression section. In the Expression text field, type down (p).
5 Locate the Levels section. In the Total levels text field, type 40.

6

Clear the Round the levels check box.

Deformation |

I Right-click Downside Pressure and choose Deformation.

2 In the Settings window for Deformation, locate the Expression section.
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3 In the x-component text field, type -nx/sqrt(down(tremetric)).

4 In the y-component text field, type -ny/sqrt(down(tremetric)).

5 In the z-component text field, type -nz/sqrt (down(tremetric)).

6 Locate the Scale section.

7 Select the Scale factor check box. In the associated text field, type 0.1.

Wall Resolution (spf)

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Wall Resolution (spf) in the Label
text field.

Wall Resolution

I Right-click Wall Resolution (spf) and choose Surface.

2 In the Settings window for Surface, type Wall Resolution in the Label text field.

3 Locate the Data section. From the Dataset list, choose Exterior Walls.

4 Locate the Expression section. In the Expression text field, type spf.Delta_wPlus.

Wall Resolution (spf)
In the Model Builder window, click Wall Resolution (spf).

Wall Resolution, Interior Walls
I In the Wall Resolution (spf) toolbar, click .‘i More Plots and choose Surface Slit.

2 In the Settings window for Surface Slit, type Wall Resolution, Interior Walls in
the Label text field.

In the Model Builder window, click Wall Resolution, Interior Walls.
In the Label text field, type Wall Resolution, Interior Walls.

Locate the Data section. From the Dataset list, choose Interior Walls.

o 1 A W

Locate the Expression on the Upside section. In the Expression text field, type
spf.Delta_wPlus_u.

7 Locate the Expression on the Downside section. In the Expression text field, type
spf.Delta_wPlus_d.

Residence time distribution

I In the Home toolbar, click @1 Add Plot Group and choose ID Plot Group.

2 In the Settings window for ID Plot Group, type Residence time distribution in the
Label text field.

3 Locate the Data section. From the Dataset list, choose Study 2/Solution 2 (sol2).
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4 From the Time selection list, choose Interpolated.

5 In the Times (s) text field, type range (0,deltaT,tEnd).
Global |

I Right-click Residence time distribution and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Expression Unit Description
1-fpt.pcnt1.Nsel/nPart 1
Global 2

I In the Model Builder window, right-click Residence time distribution and choose Global.
2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Expression Unit Description

(fpt.pcnt1.Nsel-if (t>deltaT,at(t-deltaT, 1
fpt.pcnt1.Nsel),0))/nPart

4 In the Residence time distribution toolbar, click Plot.

Residence time distribution

I In the Model Builder window, click Residence time distribution.
In the Settings window for ID Plot Group, locate the Plot Settings section.
Select the Two y-axes check box.
In the table, select the Plot on secondary y-axis check box for Global 2.

Locate the Axis section. Select the Manual axis limits check box.

2

3

4

5

6 In the y minimum text field, type 0.5.

7 In the y maximum text field, type 1.05.

8 Locate the Grid section. Select the Manual spacing check box.
9 In the x spacing text field, type 100.

10 In the y spacing text field, type 0.1.

Il In the Secondary y spacing text field, type 0.005.

Global |
I In the Model Builder window, click Global 1.
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2 In the Settings window for Glebal, click to expand the Legends section.
3 From the Legends list, choose Manual.

4 In the table, enter the following settings:

Legends

Fraction in the tank

Global 2
I In the Model Builder window, click Global 2.

2 In the Settings window for Glebal, click to expand the Coloring and Style section.
3 From the Function type list, choose Discrete.
4 Click to expand the Legends section. From the Legends list, choose Manual.

5 In the table, enter the following settings:

Legends

Residence time distribution

6 Click to collapse the Legends section. In the Residence time distribution toolbar, click

Plot.
Particle Trajectories (fpt)
I In the Model Builder window, under Results click Particle Trajectories (fpt).
2 In the Settings window for 3D Plot Group, locate the Data section.
3 From the Time (s) list, choose 100.
4 Locate the Plot Settings section. Clear the Plot dataset edges check box.

Surface |
Right-click Particle Trajectories (fpt) and choose Surface.

Surface |
I In the Model Builder window, expand the Results>Particle Trajectories (fpt) node, then
click Surface 1.

2 In the Settings window for Surface, locate the Expression section.
3 In the Expression text field, type 1.
4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Gray.
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Particle Trajectories |
I In the Model Builder window, click Particle Trajectories 1.

2 In the Settings window for Particle Trajectories, locate the Coloring and Style section.
3 Find the Point style subsection. From the Type list, choose Comet tail.
Color Expression |

I In the Model Builder window, expand the Particle Trajectories | node, then click
Color Expression |I.

In the Settings window for Color Expression, click to expand the Range section.
Select the Manual color range check box.

In the Maximum text field, type 0.3.

In the Minimum text field, type 0.

N U1 A W N

In the Particle Trajectories (fpt) toolbar, click Plot.

Geometry Modeling Instructions

Follow steps below to generate the geometry used in this model.

ADD COMPONENT
In the Home toolbar, click <> Add Component and choose 3D.

GLOBAL DEFINITIONS

Parameters |

I In the Model Builder window, under Global Definitions click Parameters I.
2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

impellerTilt 30 30 Impeller shaft tilt angle
r_in 0.08[m] 0.08 m Inlet radius

Vol 3.38[m"3] 3.38 m? Tank volume

PART LIBRARIES
I In the Home toolbar, click % Windows and choose Part Libraries.

2 In the Model Builder window, under Component | (compl) click Geometry I.

3 In the Part Libraries window, sclect Mixer Module>Tanks>flat_bottom_tank in the tree.
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4 Click T Add to Geometry.

GEOMETRY |

Flat Bottom Tank | (pil)
I In the Model Builder window, under Component | (compl)>Geometry | click
Flat Bottom Tank | (pil).

2 In the Settings window for Part Instance, locate the Input Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

n_ba 0[1] 0 Number of baffles

w_ba 0.15[m] 0.15m Baffle width

d_im 1[m] I m Impeller diameter

d ta 1.5[m] 1.5m Tank diameter

h_ta 2.0[m] 2m Tank height

rm_b_ta 0.3[m] 03 m Minor radius of the tank bottom
hp_ta 0[m] Om Height position, cylindrical surface
rf_ta 0.05[m] 0.05 m Fillet radius of lower tank edge

Union | (unil)

I In the Geometry toolbar, click @ Booleans and Partitions and choose Union.
2 Select the object pil only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 Click ™ Build Selected.

PART LIBRARIES

I In the Geometry toolbar, click _ Parts and choose Part Libraries.
2 In the Model Builder window, click Geometry 1.
3 In the Part Libraries window, sclect Mixer Module>Shafts>impeller_shaft in the tree.

4 Click T& Add to Geometry.
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GEOMETRY |

Impeller Shaft | (pi2)
I In the Model Builder window, under Component | (compl)>Geometry | click
Impeller Shaft | (pi2).

2 In the Settings window for Part Instance, locate the Input Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

hp_im 0.5[m] 05m Position of the lowest part of the impeller hub
or impeller shaft along the z-axis

I_is 2[m] 2m Impeller shaft length

PART LIBRARIES

I In the Geometry toolbar, click ¢ /\' Parts and choose Part Libraries.

2 In the Model Builder window, click Geometry 1I.

3 In the Part Libraries window, sclect Mixer Module>Impellers, Axial>

pitched_blade_impeller_constant_pitch in the tree.

4 Click T Add to Geometry.

GEOMETRY |

Pitched Blade Impeller with Constant Pitch | (pi3)
I In the Model Builder window, under Component I (compl)>Geometry | click
Pitched Blade Impeller with Constant Pitch | (pi3).

2 In the Settings window for Part Instance, locate the Input Parameters scction.

3 In the table, enter the following settings:

Name Expression Value Description

n_ib 5[1] 5 Number of impeller blades

d_im 0.8[m] 08m Impeller diameter

hp_im 0.5[m] 0.5m Position of the lowest part of the impeller

hub or impeller shaft along the z-axis

pa_cs_im 1 | Add cross-section planes for flow
evaluation above and below the impeller: |
= add planes, 0 = do not add planes.
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Rotate | (rotl)

I In the Geometry toolbar, click ), Transforms and choose Rotate.

et

Select the objects pi2, pi3(1), and pi3(2) only.

In the Settings window for Retate, locate the Rotation section.

2

3

4 From the Axis type list, choose x-axis.

5 In the Angle text field, type impellerTilt.

6 Locate the Point on Axis of Rotation section. In the z text field, type 0.5.
7

Click ™ Build Selected.
Move | (movl) .
I In the Geometry toolbar, click /), Transforms and choose Move.
2 Select the objects rotl(1), rotl(2), and rotl(3) only.
3 In the Settings window for Move, locate the Displacement section.
4 In the y text field, type -0.175.
Difference | (difl)
I In the Geometry toolbar, click @ Booleans and Partitions and choose Difference.
2 Select the objects movl(3) and unil only.
3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Click to select the =] Activate Selection toggle
button.

5 Select the objects movl (1) and movl(2) only.

Cylinder | (cyll)

I In the Geometry toolbar, click () Cylinder.
In the Settings window for Cylinder, locate the Size and Shape section.
In the Radius text field, type r_in.

In the Height text field, type r_in*8.

In the y text field, type 0.3.

2
3
4
5 Locate the Position section. In the x text field, type -0.9.
6
7 In the z text field, type 1.5.

8

Locate the Axis section. From the Axis type list, choose x-axis.

Work Plane | (wpl)
I In the Geometry toolbar, click %\— Work Plane.
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2 In the Settings window for Work Plane, locate the Plane Definition section.
3 From the Plane list, choose xz-plane.
4 In the y-coordinate text field, type -0.35.

Work Plane | (wpl)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane | (wpl)>Rectangle | (rl)

I In the Work Plane toolbar, click || Rectangle.
In the Settings window for Rectangle, locate the Size and Shape section.
In the Width text field, type 0.2.

2

3

4 In the Height text field, type 0.2.

5 Locate the Position section. In the xw text field, type 0.25.
6

In the yw text field, type -0.25.

Work Plane | (wpl)>Rectangle 2 (r2)

I In the Work Plane toolbar, click |:| Rectangle.
In the Settings window for Rectangle, locate the Size and Shape section.
In the Width text field, type 0.25.

2

3

4 In the Height text field, type 0.2.

5 Locate the Position section. In the xw text field, type 0.25.
6

In the yw text field, type -0.25.

Work Plane | (wpl)>Fillet I (fill)

I In the Work Plane toolbar, click d Fillet.

2 On the object rl, select Point 3 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type 0.03.

Work Plane | (wpl)>Difference | (difl)

I In the Work Plane toolbar, click @ Booleans and Partitions and choose Difference.
2 Select the object r2 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Click to select the @] Activate Selection toggle
button.

5 Select the object fill only.
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GEOMETRY |

Work Plane | (wpl)
In the Model Builder window, collapse the Component | (compl)>Geometry 1>
Work Plane | (wpl) node.

Revolve | (revl)
I In the Model Builder window, right-click Geometry | and choose Revolve.
In the Settings window for Revelve, locate the Revolution Axis section.
Find the Point on the revolution axis subsection. In the xw text field, type 0.5.

2

3

4 In the yw text field, type -0.25.

5 Locate the Revolution Angles section. Clear the Keep original faces check box.
6

In the Geometry toolbar, click [EE Build All.
Ignore Edges | (igel)
I In the Geometry toolbar, click St Virtual Operations and choose Ignore Edges.
2 In the Settings window for Ignore Edges, locate the Input section.
3 Click % Paste Selection.
4

In the Paste Selection dialog box, type 13, 27-29, 60, 85, 88, 90, 96, 97, 99,
101, 105, 109, 115, 116, 120, 121, 147, 148, 171, 180, 188, 189, 197,
198 in the Selection text field.

5 Click OK.

Ignore Faces | (igfl)

I In the Geometry toolbar, click == Virtual Operations and choose Ignore Faces.
2 In the Settings window for Ignore Faces, locate the Input section.

3 Click % Paste Selection.

4 In the Paste Selection dialog box, type 51 in the Selection text ficld.

5 Click OK.

6

In the Geometry toolbar, click [EE Build All.
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